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Preface

Welcome to the JD Edwards EnterpriseOne Standalone Client Using Oracle Universal 
Installer and Oracle Enterprise Edition Database Installation Guide.

Note: This guide has been updated for JD Edwards EnterpriseOne 
Tools Release 9.1 Update 2. For details on documentation updates, 
refer to the JD Edwards EnterpriseOne Tools Net Change Guide.

Audience
This guide is intended for end users that install the JD Edwards EnterpriseOne 
Standalone Client.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
You can access related documents from the JD Edwards EnterpriseOne Release 
Documentation Overview pages on My Oracle Support. Access the main 
documentation overview page by searching for the document ID, which is 876932.1, or 
by using this link:

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1

To navigate to this page from the My Oracle Support home page, click the Knowledge 
tab, and then click the Tools and Training menu, JD Edwards EnterpriseOne, Welcome 
Center, Release Information Overview.

This guide contains references to server configuration settings that JD Edwards 
EnterpriseOne stores in configuration files (such as jde.ini, jas.ini, jdbj.ini, 
jdelog.properties, and so on). Beginning with the JD Edwards EnterpriseOne Tools 
Release 8.97, it is highly recommended that you only access and manage these settings 
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for the supported server types using the Server Manager program. See the JD Edwards 
EnterpriseOne Server Manager Guide.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Introduction

This document explains how to install and run the JD Edwards EnterpriseOne 
Applications Release 9.1/Tools Release 9.1 Standalone Client using the Oracle 
Universal Installer (OUI), hereafter referred to as the Standalone Client. This version of 
the Standalone Client's installer is markedly different from the previous version that 
was available with Applications Release 9.0/Tools Release 9.1. This one uses a newer 
version of OUI (11.2), and some of the installation steps are different.

However, like the previous version, this version of the Standalone Client supports 
only the Oracle Enterprise Edition (OEE) as the local database. It does not support 
Microsoft SQL Server 2005 Express Edition (SSE).

The major steps in installing the Standalone Client include:

■ Prepare target system

Make sure your system meets the Minimum Technical Requirements. Refer to the 
section of this guide entitled: Section 2.1, "Minimum Technical Requirements".

■ Prepare the installation

Use one of the installation methods:

1. Expand the files on a set of installation DVDs to a hard drive.

2. Download and expand an image of the installation DVD from the Oracle 
Software Delivery Cloud site (http://edelivery.oracle.com).

■ Install the components

Install the local database if it is not already installed and the Standalone Client. 

This installation can include non-English languages.

■ Troubleshoot the installation

Analyze and correct any problems that arise during the installation.

Other tasks covered by this document include:

■ Start the Standalone Client

Run the client and troubleshoot any startup errors.

■ Start the Web Client

Run the web client as part of the Standalone Client and troubleshoot any startup 
errors.

■ Replace the JD Edwards EnterpriseOne Tools component
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Replace the JD Edwards EnterpriseOne Tools Release component (also known as 
"system" or "foundation" code) when a new JD Edwards EnterpriseOne Tools 
Release becomes available.

■ Deinstall (Uninstall) the Standalone Client

Remove the client and the local database, if desired.

Refer to the Glossary in this document for definitions of terms and acronyms.

Note: Microsoft Windows Slash Characters. Microsoft Windows 
syntax allows either a slash or backslash to separate directory names. 
If you are specifying directory names from this document, you may 
use either slash character.
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2Prerequisites

This chapter contains the following topics:

■ Section 2.1, "Minimum Technical Requirements"

■ Section 2.2, "Windows Security"

■ Section 2.3, "Additional Considerations"

■ Section 2.4, "Microsoft Windows Internet Protocol Version 4 (IPv4)"

2.1 Minimum Technical Requirements
Customers must conform to the supported platforms for the release as detailed in the 
JD Edwards EnterpriseOne Minimum Technical Requirements. In addition, JD 
Edwards EnterpriseOne may integrate, interface, or work in conjunction with other 
Oracle products. Refer to the following link for cross-reference material in the Program 
Documentation for Program prerequisites and version cross-reference documents to 
assure compatibility of various Oracle products.

http://www.oracle.com/corporate/contracts/index.html

For EnterpriseOne as a whole, you can access the current Minimum Technical 
Requirements (MTR) from My Oracle Support (https://support.oracle.com) by 
searching for this document:

JD Edwards EnterpriseOne Current MTR Index [ID 747323.1]

For the client MTRs, you can access the attachment (erp91_Client) within this 
document:

JD Edwards EnterpriseOne Tools 9.1.x Minimum Technical Requirements For Web 
Client, Windows Admin Client, Development or Standalone Client and Pervasive 
Devices (Doc ID 1382699.1)

The computer on which you are installing the Standalone Client needs to meet the 
MTRs of all types of clients described in this section. Therefore you should review and 
ascertain that your machine meets the requirements listed in these topics of the client 
MTR document:

■ Information Common for all Clients

■ Web Client

■ Windows Client

■ Development or Standalone Client

In addition, JD Edwards EnterpriseOne may integrate, interface, or work in 
conjunction with other Oracle products. Refer to these links:
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Oracle License and Service Agreement (OLSA)

http://www.oracle.com/corporate/contracts/olsa_main.html

The Oracle License and Services Agreement (OLSA) is the standard agreement that is 
used to license Oracle programs and acquire related services.

Oracle Program Documentation

http://www.oracle.com/technology/documentation/index.html

Access current and previously released Oracle program documentation.

PeopleSoft / JD Edwards Program Table

From the above OLSA page, refer to the below verbiage which contains links to 
available PDFs as applicable.

Your license for the program(s) may include additional license rights, which varies 
according to your order date. Review the applicable tables.

Notes:  EnterpriseOne Releases. The release of the JD Edwards 
EnterpriseOne Applications for this Standalone Client is 9.1. The 
release of the JD Edwards EnterpriseOne Tools for this Standalone 
Client is 9.1. The MTRs refer to the Tools release level.

Third-party software. Read the section entitled: Additional 
Considerations before installing any additional third-party software.

Deinstall versus uninstall OUI uses the term "deinstall" to mean 
removal of an Oracle product. This document will do the same.

2.2 Windows Security
When installing, uninstalling/deinstalling, or running any JD Edwards EnterpriseOne 
product on Microsoft Windows operating systems, be sure to follow the below 
guidelines. This includes saving or restoring or deleting snapshots of EnterpriseOne 
using the Snapshot program. Not following these guidelines may cause unexpected 
errors to occur.

■ Section 2.2.1, "Registry and directory permissions"

■ Section 2.2.2, ""Run as Administrator""

■ Section 2.2.3, "Remote Desktop Connections"

2.2.1 Registry and directory permissions
Be sure that the user account into which you are signing into Windows is in the 
Administrators group or a similar group that provides permissions to write to and 
read from registry hives (for example, HKEY_LOCAL_MACHINE\SOFTWARE) and 
disk subdirectories (c:\Windows) that are restricted from standard Windows users.

2.2.2 "Run as Administrator"
If the Microsoft security User Access Control (UAC) is turned on, right-click on a 
program's icon or shortcut and select "Run as administrator." If a shortcut is 
configured to automatically "Run as administrator," you do not need to right-click and 
select "Run as administrator."
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If a file that you need to edit and then save is located in a directory with access 
restricted by UAC, you will need to right-click on the icon of your text editor program, 
select "Run as administrator," and open the file from within the editor. If you do not 
follow those steps and UAC is turned on, you may not be able to save the modified 
file.

2.2.3 Remote Desktop Connections
When connecting to a remote Windows computer using Microsoft Remote Desktop, 
run Remote Desktop with the "/admin" flag. Not running with this setting may cause 
subtle, difficult-to-explain errors in the program. You can do this using these steps:

1. Right-click on the Remote Desktop shortcut.

2. Select properties.

3. Click on the Shortcut tab.

4. At the end of the Target field, add a space, a forward slash, and "admin" (without 
the quotes) to the end of the Target. The screen shot sample below illustrates this 
setting:
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2.3 Additional Considerations

Caution: To minimize the possibility that the Standalone Client's 
installer or deinstaller or Snapshot might fail due to locked files, 
follow these guidelines: 

1. Exit from all running programs. You can use Microsoft Windows Task 
Manager to verify that the programs are stopped. In particular, be sure 
that EnterpriseOne, JDeveloper, and SQL Developer are stopped, but 
other programs may also need to be stopped. Exceptions to this rule 
include the database service(s) which should be running.

2. Verify that no files in the Standalone Client installation directory or 
subdirectories are open in any file editors.

3. Verify that neither the installation directory nor any of its subdirectories 
are open in Microsoft Windows Explorer.

4. Verify that no Command Prompt window has as its current working 
directory either the Standalone Client installation directory or any of its 
subdirectories.

1. Be sure the MTRs are met before starting the Standalone Client installation.

2. JDK 1.6 is supplied with the installation. Do not replace this with another version 
of the JDK because JDK 1.7 and higher have not been validated with 
EnterpriseOne Tools Release 9.1. Also, do not replace this JDK with a 64-bit 
version because EnterpriseOne is a 32-bit program which requires a 32-bit version 
of the JDK even when running on a 64-bit version of Microsoft Windows.

3. Microsoft Visual Studio is not required unless you are building business functions. 
The installation of the Standalone Client installs the Microsoft libraries that are 
necessary to run EnterpriseOne, but if you plan to build business functions, you 
will need the compiler and additional libraries that Visual Studio provides.

4. Verify that all previous releases of JD Edwards EnterpriseOne (Standalone Clients 
and normal clients) have been completely deinstalled or saved via Snapshot before 
installing the Standalone Client. For instructions on how to deinstall the 
Standalone Client, refer to the section of this guide entitled: Section 9.1, 
"Deinstalling the Standalone Client".

5. Standalone Client does not require Software Protection Codes (SPCs) to run so you 
will not need to perform the steps for applying SPCs that previous EnterpriseOne 
releases required.

6. This version of the Standalone Client using OUI supports only the Oracle 
Enterprise Edition (OEE) as the local database. This version of Standalone Client 
using OUI does not support Microsoft SQL Server 2005 Express Edition (SSE).

7. This release of the Standalone Client contains a 64-bit version of Oracle Enterprise 
Edition (OEE) 11gR2. If you previously had installed OEE 11gR2 as the local 
database and you are reinstalling the Standalone Client, you do not have to 
deinstall the database first. However, if you previously had installed OEE 10g or 
you need to reinstall the 11gR2 database for some reason, follow the instructions in 
the section of this guide entitled: Section 9.2, "Deinstalling the OEE Database 
(optional)".

8. If you need to install the OEE database and the Microsoft Windows environment 
variable ORACLE_HOME exists, the OEE installer will delete it during the 
installation.
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2.4 Microsoft Windows Internet Protocol Version 4 (IPv4)
Both the JD Edwards EnterpriseOne Standalone client and Development Client require 
Microsoft Windows Internet Protocol Version 4 (IPv4) for connectivity. Neither client 
can function using IPv6. 

If your Standalone installation is not working as expected, use this procedure to 
determine if the problem is due to your Windows machine using IPv6 and if so, to 
remedy:

1. After installing the local Oracle database, use a text editor to open the log.xml file 
which is typically located in this directory 

C:\Oracle\diag\tnslsnr\[MACHINE NAME]\listener\alert\.

2. Examine the contents of the log.xml file for indicators that the machine is using 
IPv6 addresses.

IPv6 addresses can be distinguished by alphanumeric digits separated by colons, 
rather than periods as in IPv4 addresses.

One example is if you see host_addr='::1'>. This indicates an IPv6 address, 
which in this case is the machine's local loopback address, whose equivalent IPv4 
address is 127.0.0.1. 

Another example that indicates the use of IPv6 is if this string exists:

host_addr='fe80::7045:1aba:cb6d:1b50%13' 

3. If you see references to IPv6 addresses in the logs after installing the Oracle local 
database, then you may need to deinstall the Standalone Client and Oracle 
database as described in the chapter of this guide entitled: Chapter 9, "Deinstalling 
the Standalone Client or the OEE Database (optional)". 

Also, you may possibly need to perform additional cleanup for the standalone 
client and Oracle Database as described in these appendices of this guide: 
Appendix A, "Manual Cleanup of a Deinstalled Standalone Client" and 
Appendix B, "Manual Cleanup of a Deinstalled Oracle Database".

4. After the deinstall and cleanup is complete, you must apply a software patch from 
Microsoft to disable IPv6 before reinstalling the Oracle local database and 
EnterpriseOne Standalone or Web Development Client. The Microsoft patch for 
disabling IPv6 is at the following link: 

How to disable IPv6 or its components in Windows 

http://support.microsoft.com/kb/929852

On the above Microsoft web page, click the link labelled Disable IPv6 (Microsoft 
Fix it 50409).

5. After you apply the Microsoft patch to disable IPv6, you can reinstall the Oracle 
database and EnterpriseOne Standalone Client using the procedures in this guide.



Caution: MICROSOFT DISCLAIMER ON DISABLING IPV6

Important: Internet Protocol version 6 (IPv6) is a mandatory part of 
Windows Vista and later versions. We do not recommend that you 
disable IPv6 or its components, or some Windows components may 
not function. For more information, see the "What are Microsoft's 
recommendations about disabling IPv6?" question in IPv6 for 
Microsoft Windows: Frequently Asked Questions at this link:

http://technet.microsoft.com/en-us/network/cc987595.aspx

Microsoft Windows Internet Protocol Version 4 (IPv4)
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3Installation Methods

This chapter contains the following topics:

■ Section 3.1, "Overview"

■ Section 3.2, "Copying the Installation DVD"

■ Section 3.3, "Downloading from the Oracle Software Delivery Cloud Site"

■ Section 3.4, "Updating the tnsnames.ora File"

3.1 Overview
Depending on several factors, you can install the Standalone Client using one of these 
methods:

Method Method Requirements

From a copy of a set 
of installation DVDs

You have a set of installation DVDs.

Use the procedures described in the section in this chapter entitled: 
Chapter 3.2, "Copying the Installation DVD".

From a Oracle 
Software Delivery 
Cloud download

You have access to the Oracle Software Delivery Cloud site.

Use the procedures described in the section in this chapter entitled: 
Chapter 3.3, "Downloading from the Oracle Software Delivery 
Cloud Site".

3.2 Copying the Installation DVD
Perform these steps if you are expanding a set of installation DVDs to a hard drive, 
either locally or to a network location. You may want to use a network location so 
additional users can install from a single location.

To copy the installation DVD
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1. On the hard drive onto which you want to expand the installation DVDs, create a 
temporary installation directory. The recommended name is:

\Standalone_9.10

2. Expand the contents of the installation DVDs to the temporary installation 
directory you created in Step 1 above.

3. Place the expanded contents of the DVD(s) that contain the 64-bit Oracle database 
into this directory:

\Standalone_9.10\ThirdParty\ORACLE

Note: JDBC Drivers and JDK. All files necessary to perform the 
installation, including JDBC drivers and a JDK, now reside in the 
temporary installation directory. If you followed the recommendation, 
the directories are named: 

\Standalone_9.10\ThirdParty\WebDevFeature\OH4A\JDBC

\Standalone_9.10\ThirdParty\WebDevFeature\OH4A\JDK

3.3 Downloading from the Oracle Software Delivery Cloud Site
Complete these instructions if you are downloading the Standalone Client software 
from the Oracle Software Delivery Cloud site:

http://edelivery.oracle.com

If you are installing the Standalone Client from an expanded set of installation DVDs 
or a network share location, and therefore have performed the steps in the preceding 
section of this chapter, you can skip this section and proceed to Section 3.4, "Updating 
the tnsnames.ora File".

To download the Standalone Client from the Oracle Software Delivery Cloud:

1. On your client machine, create a temporary installation directory. The 
recommended name is:

\Standalone_9.10
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2. Access the Oracle Software Delivery Cloud site, continue through the screens, and 
select these values on the Media Pack Search screen:

■ Select a Product Pack: JD Edwards EnterpriseOne

■ Platform: Microsoft Windows x64 (64-bit) 

3. Click the Go button to display the results.

4. In the results grid, click the radio button next to the proper description. There are 
not separate downloads for English and non-English languages. The description is 
entitled:

■ JD Edwards EnterpriseOne 9.1 Applications/9.1 Tools Media Pack for 
Microsoft Windows (64-bit)

5. Click Continue.

6. Locate the item with the description:

■ JD Edwards EnterpriseOne 9.1 English and Language Standalone 

or

■ JD Edwards Applications 9.1 Update 2 Stand Alone

7. Click the Download button next to the item that you wish to download. Make sure 
you have downloaded all the files for each CD image. For Standalone in English 
there are four (4) images. For Standalone with Languages, there is an additional 
image for a total of five (5) images.

Note:  Multiple Parts Downloads. Due to the maximum file size 
restrictions for downloads on Oracle Software Delivery Cloud, you 
will need to download multiple parts for a selected part number.

8. Save the .zip files of the CD images to the temporary installation directory you 
created in Step 1. If you followed the recommendation, the directory is named

\Standalone_9.10

9. After you finish downloading the first item, labeled (Part 1 of 4), select the 
corresponding row for the second item labeled (Part 2 of 4) and click the 
Download button. Do the same for the remaining parts 3, 4, and 5 (if downloading 
languages). The parts are organized as follows:

English Standalone (4 images)
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Part 1 of 4 (download into the Standalone install location)

Part 2 of 4 (download into the Standalone install location)

Part 3 of 4 (download into the OEE install location)

Part 4 of 4 (download into the OEE install location)

Languages Standalone (5 images)

Part 1 of 5 (download into the Standalone install location)

Part 2 of 5 (download into the Standalone install location)

Part 3 of 5 (download into the Standalone install location)

Part 4 of 5 (download into the OEE install location)

Part 5 of 5 (download into the OEE install location)

10. Again, save the .zip file to the same directory where you saved the previous .zip 
file.

11. After you finish downloading all parts of your item, use your preferred unzip 
program to extract the contents of the first two parts (English Standalone) or the 
first three parts (Languages Standalone) to the temporary installation directory 
that you created in Step 1. If you followed the recommendation, the directory is 
named:

\Standalone_9.10

Note: Extract Option. When extracting, be sure to click in the check 
box to enable this option:

Use folder names

12. In the same manner, extract the final two .zip files (for English Standalone, parts 3 
and 4; for Languages Standalone, parts 4 and 5), which contain the 64-bit Oracle 
database, into this directory: 

\Standalone_9.10\ThirdParty\ORACLE

Note: JDBC Drivers and JDK. All files necessary to perform the 
installation, including JDBC drivers and a JDK, now reside in the 
temporary installation directory. If you followed the recommendation, 
the directories are named: 

\Standalone_9.10\ThirdParty\WebDevFeature\OH4A\JDBC

\Standalone_9.10\ThirdParty\WebDevFeature\OH4A\JDK

This example screen illustrates the directory structure when the .zip files are 
extracted into the recommended temporary installation directory (\Standalone_
9.10):
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3.4 Updating the tnsnames.ora File
The file tnsnames.ora contains information about how to connect to an Oracle 
database. A default tnsnames.ora file is provided in the \Standalone_9.10\client 
directory that provides the necessary information to connect to an Oracle database 
called E1Local that will be installed on the workstation where you are installing the 
Standalone Client.

If you have other Oracle databases installed on this machine, or if you access remote 
Oracle databases, you will have other tnsnames.ora files to define those connection 
parameters.

By design, the tnsnames.ora for the last installed Oracle database is used by any 
software running on your local machine to access all the Oracle databases. Because the 
E1Local database is normally installed during the installation of the Standalone Client, 
it is likely that it will be the last database installed. Therefore, in order to regain 
connectivity to other Oracle databases, you must update the tnsnames.ora file used by 
E1Local with the database connection information that is stored in the other 
tnsnames.ora files on your machine.  

Later instructions in this document will have you copy the tnsnames.ora that resides 
in the \Standalone_9.10\client directory to various places on your workstation. 
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Because this file will be copied, you should update it before performing any copies or 
the installation of the Standalone Client.

To update the tnsnames.ora file:

1. Edit the new tnsnames.ora file located in this path:

\Standalone_9.10\client\tnsnames.ora

2. Edit the tnsnames.ora files on your machine for any other Oracle databases that 
you may access (whether remote or local databases). These tnsnames.ora files will 
be located in the \NETWORK\ADMIN path under the installation paths of the Oracle 
database clients. For example:

C:\Apps\Mydb\oracle112\NETWORK\ADMIN\tnsnames.ora

3. Copy the contents of these other tnsnames.ora files and append them to the 
version of the file that is in this directory:

\Standalone_9.10\client
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4Installing the Standalone Client

This chapter contains the following topics:

■ Section 4.1, "Overview"

■ Section 4.2, "Understanding Destination Paths"

■ Section 4.3, "Installing the Local Database"

■ Section 4.4, "Installing the EnterpriseOne Client"

■ Section 4.5, "Troubleshooting the Installation"

4.1 Overview
Before You Begin

■ Verify that your system meets the Minimum Technical Requirements.

You can install the Standalone Client from a copy of the installation DVDs or a 
download from Oracle Software Delivery Cloud. Refer to Chapter 3, "Installation 
Methods"for additional details.

Notes:  Assumptions. Because you are installing from either a copy 
of the installation DVDs or a download from Oracle Software Delivery 
Cloud, the installation program will be in the directory into which you 
expanded the DVDs or downloaded files. If you followed the 
recommendation, this directory is: 

C:\Standalone_9.10

As is the case with all installations on Microsoft Windows machines 
(including Microsoft Windows 7), in order to run the installer for the 
Standalone Client, you must be logged onto Microsoft Windows as a 
user with Administrator rights.

Installing the Standalone Client involves first installing a local database and then 
installing the actual EnterpriseOne Standalone Client. Follow the instructions in the 
next two sections to install the database and client.

4.2 Understanding Destination Paths
As of Tools Release 9.1, the Standalone Client is installed using the Oracle Universal 
Installer (OUI) version 11.2. In addition, the Web Client component is installed as a 
package feature using OUI.
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Each Oracle product that is installed on a machine is installed into an Oracle Home 
directory or path. This is a directory that contains most of the files associated with the 
product. This path has a name as well. You can specify a name that is intuitive so you 
do not have to remember the path.

When you install the Oracle Enterprise Edition (OEE) database engine on the 
Standalone Client's workstation, by default the Oracle Home path will be:

c:\Oracle\E1Local

The value E1Local cannot be changed, but you may specify another drive and/or 
directory instead of the default value, which is c:\Oracle. The Oracle Home name for 
the OEE database is E1Local.

When you install the Standalone Client, you specify an Oracle Home path and name 
for that installation as well. For example, you may enter C:\JDEdwards\E910 as the 
Oracle Home path and JDE_Standalone_Home as the Oracle Home name.

Caution: Do not specify a path with a space in its name.

Following the above examples, you would now have two Oracle Homes:

1. The first Oracle Home is the Oracle Home of the database; it has these properties:

■ Oracle Home Path

C:\Oracle\E1Local

■ Oracle Home Name

E1Local

2. The second Oracle Home is the Oracle Home of the Standalone Client; it has these 
properties:

■ Oracle Home Path

C:\JDEdwards\E910

■ Oracle Home Name

JDE_Standalone_Home

During the installation of a Standalone Client installation package, OUI will copy the 
files from the package to subdirectories under the Oracle Home path and then perform 
the necessary configurations. In addition, it places a copy of OUI into the Oracle Home 
Path.

OUI also creates a submenu of items in the Start > All Programs menu. This submenu 
is named "Oracle - <Oracle_Home_Name>" where <Oracle_Home_Name> is the name 
that the user specified during the installation. This submenu will include a link to the 
EnterpriseOne Solution Explorer and another submenu for Oracle Installation 
Products. Oracle Installation Products includes a link to the copy of OUI that is in the 
Oracle Home Path. Although you can run other copies of OUI to deinstall (remove) the 
EnterpriseOne Standalone Client, it is safest to deinstall using the link in Start > All 
Programs > Oracle - Oracle_Home_Name > Oracle Installation Products > Universal 
Installer.

4.3 Installing the Local Database
This release of the Standalone Client contains a 64-bit version of Oracle Enterprise 
Edition (OEE) 11gR2. Thirty-two bit OEE 11gR2 is not supported on 64-bit versions of 
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Windows. If you previously had installed 64-bit OEE 11gR2 as the local database and 
you are reinstalling the Standalone Client, you do not have to reinstall the database 
first. However, if you previously had installed OEE 10g or you need to reinstall the 
11gR2 database for some reason, follow the instructions in the section of this guide 
entitled: Section 9.2, "Deinstalling the OEE Database (optional)".

Caution: It is very important that no files exist in the "E1Local" 
subdirectory when you next attempt to install the OEE database. If 
any files do exist, the OEE installation will probably fail.

When OEE is installed, it will be installed into a subdirectory called E1Local under a 
database target directory. By default, this database target directory is C:\Oracle. This 
means that the database will be installed into C:\Oracle\E1Local by default.

If you cannot delete the E1Local subdirectory because a file in that directory is locked, 
follow these steps:

1. Determine which file is locked and which process has the lock on the file. A 
freeware program called Process Explorer can be helpful in determining this 
information. You can obtain a free copy of Process Explorer from this web site:

http://technet.microsoft.com/en-us/sysinternals

2. Either kill the locking process with Process Explorer or Microsoft Windows Task 
Manager or, if the process was started as a Microsoft Windows service, change the 
Startup Type to Manual and reboot the computer again.

3. Try again to delete the E1Local subdirectory.

To run the local database installer:

1. Launch InstallManager.exe from the temporary installation directory. For 
example:

\Standalone_910

Note:  When running the installation program and UAC is turned 
on, you must right click on the executable or shortcut and select Run 
as Administrator.
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2. On JD Edwards Install Manager, click this link:

EnterpriseOne Database Engine

If the database is already installed, the program will display a message indicating 
that condition. If the database is not installed, you may be prompted for the target 
directory for the database. The default location is C:\Oracle. The database will be 
installed into a folder called E1Local under the target directory. For example:

C:\Oracle\E1Local

The InstallManager.exe decompresses the .cab files using the OEESetup.exe 
program. The status of the decompression is displayed in a Command window. If 
the decompression appears to hang, it may be because you did not run as an 
administrator, or you did not extract all the expected .cab files from the .zip files.

After the .cab files are decompressed, OEESetup.exe continues through various 
phases of the installation. This process can take quite awhile, perhaps up to 30 
minutes. During these phases, multiple Command windows will open and close 
as the installation continues. Lastly the installation copies the database files and 
then performs Oracle database instance functions, while indicating progress. After 
the installation completes successfully, all Command windows are closed and this 
dialog is displayed:
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3. When the installation of the database finishes, the Reboot dialog is displayed. You 
must reboot before you can continue with the installation of additional 
EnterpriseOne Standalone components.

Caution: Examine the Installer Logs. Even though the screen says 
that the installation was successful, you should perform a quick 
determination that all the database installation steps were successful 
before clicking Exit. Follow these steps:

1. From Control Panel, run Administrative Tools / Services.

2. In the list of Services, look for the services named 
OracleE1LocalTNSListener and OracleServiceE1LOCAL.

3. If either one of these is missing, there was a problem in completing all the 
installation and configuration steps. Examine these logs:

c:\OEEInstall.log

c:\Oracle\cfgtoollogs

c:\Oracle\E1Local\cfgtoollogs

You will probably need to deinstall the database engine using the 
steps in Section 9.2, "Deinstalling the OEE Database (optional)", 
reboot, and then reinstall the OEE database.

4. Reboot your machine.

5. Install 32-bit database drivers.

Note: 64- vs. 32-bit Oracle database drivers. Because JD Edwards 
EnterpriseOne is a 32-bit program, it needs to load 32-bit Oracle 
database driver DLLs; however, you should have installed a 64-bit 
Oracle database in the steps above. Therefore, you also need to install 
32-bit Oracle database driver DLLs. These 32-bit DLLs are provided 
by a 32-bit Oracle database client. You can download the 32-bit Oracle 
database client from the Oracle Software Delivery Cloud:

https://edelivery.oracle.com/

From that site, search for:

Oracle Database 11g Release 2 Client (11.2.0.1.0) for Microsoft 
Windows (32-bit), Oracle part number V20606-01

When installing the database client, be sure to select "Runtime" on the 
Select Installation Type screen.



Caution: PATH environment variable. When you installed the 64-bit 
Oracle database, the installer placed the path to the database (for 
example, c:\Oracle\E1local\bin) at the start of the Windows PATH 
environment variable. Then when you installed the 32-bit Oracle 
database client, the installer placed the path to the database client (for 
example, c:\Oracle\product\11.2.0\client_1\bin) at the start of 
the Windows system PATH. 

When EnterpriseOne runs, it looks for database drivers in each 
directory from start to finish in the PATH. The first occurrence of a 
driver DLL that EnterpriseOne finds will be loaded. This means that 
the path to the 32-bit Oracle database client must come before the 
path to the 64-bit Oracle database.

If you installed the 64-bit database and 32-bit database client in that 
order, the order in the PATH should be correct. However, if you 
installed them in the opposite order, you need to correct the order in 
the PATH.

To reverse the order of the 64-bit database and 32-bit database client 
paths in the Windows PATH, follow these steps:

1. From the Start button, select Control Panel and then System.

2. On the left side of the window that comes up, click Advanced system 
settings.

3. Click the Advanced tab.

4. Click the Environment Variables… button.

5. In the "System variables" box, highlight the variable Path and click the 
Edit… button.

6. In the Variable value field, cut the 32-bit database client path and the 
following semicolon. For example:

c:\Oracle\product\11.2.0\client_1\bin;

7. Paste the client path and semicolon at the start of the Path value.

8. Click OK.

9. Click OK to exit from the Environment Variables window.

10. Click OK to exit from the System Properties window.

11. Close the System window of the Control Panel.
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Note: Multiple copies of the tnsnames.ora. Various components of 
EnterpriseOne and the Oracle database look for copies of 
tnsnames.ora in different paths. For EnterpriseOne and the Oracle 
database to work correctly all of these copies of tnsnames.ora must 
contain identical information.

The Standalone Client installer will copy the tnsnames.ora to the 
places that EnterpriseOne uses; however, it cannot copy them to the 
locations required by the 64-bit Oracle database and the 32-bit Oracle 
database client. You must manually copy the tnsnames.ora to 
locations under the Oracle database and the database client 
installation directories using these steps:

1. Copy the tnsnames.ora:

from:  \Standalone_9.10\client\tnsnames.ora

to: <64-bit Oracle Database Install Dir>\network\admin

For example:

c:\Oracle\E1Local\network\admin

2. Copy the tnsnames.ora:

from:  \Standalone_9.10\client\tnsnames.ora

to: <32-bit Oracle Client Install Dir>\network\admin

For example:

c:\Oracle\product\11.2.0\client_1\network\admin
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4.4 Installing the EnterpriseOne Client
To run the EnterpriseOne Client installer

1. Launch InstallManager.exe from the temporary installation directory (for 
example, \Standalone_910).

Note: When running the installation program and UAC is turned on, 
you must right click on the executable or shortcut and select Run as 
Administrator.
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2. On JD Edwards Install Manager, click this link:

EnterpriseOne E910 Standalone Client

3. On Welcome, click the Next button.
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4. On Oracle License Agreement, if you accept the license click the appropriate 
button. You cannot continue with the installation unless you accept the license 
agreement. 

Note: The following screen is displayed only the first time you run 
the Oracle Universal Installer (OUI) on this machine. Otherwise the 
next screen displayed will be entitled: Specify Home Details. 
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5. On Specify Inventory directory, you can accept the default path or specify a 
different path if you wish.

6. Click the Next button.
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7. On Specify Home Details, you must specify an Oracle Home path and a name for 
that path. The default values are:

■ Name

JDE_Standalone_Home

■ Path

C:\JDEdwards\E910

Each Oracle product that is installed on a machine has what is termed an Oracle 
Home path. This path contains all the files for each Oracle product. This path has a 
user-specified name as well.

The path you enter here is for the Oracle Home path where the Standalone Client 
will be installed.

Caution: Do not specify the same Oracle Home name or path into 
which you installed the local database. However, you can specify a 
path that is at the same level as the Oracle Home of the database; that 
is, the Standalone Client and the database Oracle Homes can share the 
same parent directory.

Do not specify a path with a space in its name.



Note: OUI appends a number to the end of the default Oracle Home 
name and path. This number is initially "1." If an Oracle Home already 
exists with the given default name and path, OUI will increment this 
number in both the name and path. You do not have to accept the 
default values; you can enter your own name and path values.
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8. Click the Next button.

9. On Package Selection, only one package is shown for the Standalone Client. That 
package is called DEMO and is highlighted by default.

10. Click the Next button.
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11. On Install Mode, select the type of EnterpriseOne objects to install:

■ Development

These are needed if you plan to modify EnterpriseOne objects such as business 
functions, applications, forms, and so on. 

■ Production

Select this type if you do not plan to modify EnterpriseOne objects.

12. Click the Next button.
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13. On Summary, verify that what will be installed is what you expect, keeping in 
mind that the summary is segmented into two parts, where:

■ Space Requirements in the upper half of the window show the space that 
OUI requires for its support files. This space does not include the size of the 
package that you selected. You may need to use the vertical scroll bar for this 
segment to view the contents in its entirety.

■ Package Disk Space Requirements shown in the lower half of the window 
are for the package being installed. You may need to use the vertical scroll bar 
for this segment to view the contents in its entirety. 



Note: The following checks determine if enough disk space is 
available and the required database is installed: 

■ Available Disk Space

After you click Install, the installer compares the selected package 
size with the amount of free disk space of the destination path. If 
not enough free disk space exists, the installer displays a warning. 
The size of the selected package applies to a new installation of all 
components of the package. If you are sure that enough disk space 
really exists (perhaps a file deletion is in progress and has not 
finished), you can ignore the warning and continue with the 
installation; otherwise, free up the necessary disk space or use the 
Back button to back up to the Specify Home Details screen to 
select a different drive onto which the Standalone Client will be 
installed. You can then continue with the installation.

■ Available Database

If you have not installed the OEE database engine prior to 
attempting to install the Standalone Client, you will receive an 
error message at this time. If that occurs, use the Cancel button to 
exit OUI. This will take you to the InstallManager screen where 
you can select the option to install the Database Engine. When 
that installation completes, you will need to reboot your machine, 
rerun InstallManager, and select the option to install the 
Standalone Client.
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14. Click the Install button.

The progress screen shows the progress of the installation. 
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The bottom portion of the progress screen shows the name of the log file. For 
example:

Note: The elapsed time to complete the Standalone installation can 
be considerable, perhaps upwards of 30 minutes.

After the main part of the installation completes, OUI will spawn a second OUI 
window to run Configuration Assistants with a Status of In progress... For 
example:
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After the Configuration Assistants process is complete, that OUI window closes 
and the original OUI displays the End of Installation screen.



Caution: Examine the Installer Logs. Regardless of whether you get 
the above message indicating the Standalone Client installer 
succeeded, you should always check the logs before you attempt to 
run the Standalone Client. Examine the logs specified in Section 4.5, 
"Troubleshooting the Installation".
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15. Click the Exit button.

16. Perform the tasks in the section of this guide entitled: Section 5.2, "Post Installation 
- Set Up Media Object Queues".

4.5 Troubleshooting the Installation
Whether the installation appears to finish successfully or not, you should always 
examine the log files. The reason is because not all errors are propagated up to OUI 
where the main Graphical User Interface can display an error message box.

These are the keywords on which you should search for within the log files:

■ SEVERE

This indicates that an error occurred that should not be ignored.

■ Exception

Some of these may be ignored. You have to determine if they are serious enough to 
warrant concern. For example, an exception that occurs when copying a file may 
not be of concern to you because you will not use the Standalone Client 
functionality associated with that file. If you are in doubt whether or not you can 
ignore an error, contact Oracle Global Customer Support.

This section discusses these troubleshooting topics:

■ Section 4.5.1, "Standalone Client"

■ Section 4.5.2, "OEE Local Database"

4.5.1 Standalone Client
Because the Standalone Client installer runs as a 32-bit program, its installation logs on 
64-bit versions of Microsoft Windows are located at:

C:\Program Files (x86)\Oracle\inventory\logs

When the installation completes, the logs relevant to the current installation are copied 
to this directory:

<Oracle_Home_dir>\cfgtoollogs

4.5.2 OEE Local Database
The log for OEESetup.exe which spawns the OEE database installer (OUI) is:

c:\OEEInstall.log

Because the 11.2 OEE database installer runs as a 64-bit program, its installation logs 
on 64-bit versions of Microsoft Windows are located in this directory:

C:\Program Files\Oracle\inventory\logs



Troubleshooting the Installation

Installing the Standalone Client 4-19

Because the 32-bit OEE database client installer runs as a 32-bit program, its 
installation logs are located in this directory:

C:\Program Files (x86)\Oracle\inventory\logs

When the installation completes, the logs relevant to the current installation are copied 
to this directory:

<Oracle_Home_dir>\cfgtoollogs
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5Starting the Standalone Client

This chapter contains the following topics:

■ Section 5.1, "Overview"

■ Section 5.2, "Post Installation - Set Up Media Object Queues"

■ Section 5.3, "Troubleshooting Standalone Client Startup Errors"

5.1 Overview
To start the Standalone Client

1. Launch the Standalone Client by double clicking the shortcut EnterpriseOne 
Solution Explorer either on your desktop or under this navigation: Start > All 
Programs > Oracle - JDE_Standalone_Home where JDE_Standalone_Home is the 
name of the Oracle Home that you designated when installing the EnterpriseOne 
client.

Optionally, you can run the program activConsole.exe from this path:

C:\JDEdwards\E910\system\bin32

Note: When running activConsole.exe and UAC is turned on, you 
must right click on the executable or shortcut and select Run as 
Administrator.
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2. On JD Edwards EnterpriseOne Login, enter the default user ID, which is DEMO 
and the default password, which is also DEMO. If the environment and role fields 
are shown, you can accept the defaults, which are environment DEMO910 and 
role *ALL.

3. If you have installed any Oracle Business Accelerators (OBA), click the Options 
button to display the environment and role fields. In this case, you should enter 
the role: DEMOROLE and take the default environment: DEMO910.

4. Click the OK button to log in to the Standalone Client.

Note: Startup Time. You should allow sufficient startup time for the 
JD Edwards EnterpriseOne background process jdenet_n.exe, which 
acts as the security server on the Standalone Client. Ensure this 
program has completed its initialization steps before you click OK on 
the logon screen. 

Depending on machine resources, you may have to wait up to 30 
seconds before signing in. If you get an error indicating failure to 
connect to the Security Server, exit from EnterpriseOne and then retry 
running activConsole.exe giving a bit more time before clicking OK 
on the logon screen.

5.2 Post Installation - Set Up Media Object Queues
Table F98MOQUE contains the path to media objects; however, this table is shipped 
with generic paths. The table must be manually updated to include the correct paths 
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for your installation. If this table is not updated, you will receive errors when 
attempting to access media objects.

To setup up media object queues:

1. Launch the Standalone Client and log in.

2. Run the EnterpriseOne application P98MOQUE.

3. On Work With Media Object Queues, click the Find button.
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Most of the records found should be prefixed with the string below in the Queue 
path On-Line column:

\\SERVERNAME\E910

4. You must manually replace the string \\SERVERNAME\E910 in Queue path On-Line 
with the installation path of the Standalone Client. For example, if one of the 
entries is:

\\SERVERNAME\E910\MEDIAOBJ\SELFSERVICE

And the installation directory is c:\E910_1, change the entry to:

C:\E910_1\MEDIAOBJ\SELFSERVICE

5. Click the Close button to exit the application.

5.3 Troubleshooting Standalone Client Startup Errors
This section describes these troubleshooting tasks:

■ Section 5.1, "Overview"

■ Section 5.2, "Post Installation - Set Up Media Object Queues"

■ Section 5.3, "Troubleshooting Standalone Client Startup Errors"
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5.3.1 General
If you have any trouble running the Standalone Client, turn on additional logging and 
rerun the Standalone Client.

1. Run the Microsoft Windows Task Manager.

2. Click the Processes tab.

3. If the column titled PID is not displayed, use this procedure to turn it on:

a. In the menu, go to View > Select Columns…

b. Turn on the check box next to PID (Process Identifier).

c. Click OK.

4. Kill these processes if they are running:

■ activConsole.exe

■ jdenet_n.exe

5. Edit this file:

c:\Windows\jde.ini

6. In the [DEBUG] section, change the value of the Output key to FILE, as shown 
below:

[DEBUG]
Output=FILE

7. Note the names of the log files specified for the JobFile and DebugFile keys in the 
Debug section so you can locate them when needed. If no directory is specified, 
the files will reside in the root directory.

8. Run activConsole.exe from this directory:

C:\JDEdwards\E910\system\bin32

9. Attempt to sign into the Standalone Client.

Logs are generated in the directory specified by the JobFile and DebugFile keys in 
the [DEBUG] section of the jde.ini. However, the names of the files will be of the 
forms jde_pid_mmddyy.log and jdedebug_pid_mmddyy.log where:

■ pid is the ID of the process generating the log.

■ mmddyy is the month, day, and year in which the log was generated.

You can determine which process ID belongs to each EnterpriseOne process by 
noting the process IDs and names shown in the Microsoft Windows Task Explorer 
and by examining the first few lines of the generated logs.

5.3.2 Cannot Connect to the Security Server
Problem:

You get an error (either in a pop-up window or in the logs) indicating that the 
Standalone Client could not connect to the security server.

Resolution:

Try the following:

1. Try again to sign on. The security server (process jdenet_n.exe) may have simply 
been slow in starting causing the activConsole.exe to time out.
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2. By default, the Standalone Client attempts to start the web client at the same time 
that activConsole.exe starts. This could cause the security server (process 
jdenet_n.exe) to take too long to start causing the activConsole.exe to time out.

You can specify that the web client should start only when you attempt to bring up 
the Web menu (described in the next section entitled: Still Cannot Connect to the 
Security Server). To do so, follow these steps:

a. Run the Microsoft Windows Task Manager.

b. Kill these processes if they are running:

activConsole.exe

jdenet_n.exe

c. Edit the c:\windows\jde.ini file.

d. Change the value of the StartAppServer key in the [LOCALWEB] section to 
ONDEMAND. For example:

[LOCALWEB]
StartAppServer=ONDEMAND

e. Rerun activConsole.exe.

5.3.3 Still Cannot Connect to the Security Server
Problem:

After doing the above, you again get an error (either in a pop-up window or in the 
logs) indicating that the Standalone Client could not connect to the security server.

Resolution:

Verify that the local database services are running using this procedure:

1. Go to Start > Control Panel > Administrative Tools > Services.

2. Verify that the statuses of these services are Started:

■ OracleServiceE1LOCAL

■ OracleE1LocalTNSListener

If not, for each stopped service click Action > Start in the menu.

3. Try to sign in again by following these steps:

a. Run the Microsoft Windows Task Manager.

b. Kill these processes if they are running:

activConsole.exe
jdenet_n.exe

c. Rerun the activConsole.exe program.
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6Starting the Standalone Web Client

This chapter contains the following topics:

■ Section 6.1, "Overview"

■ Section 6.2, "Troubleshooting Standalone Web Client Startup Errors"

6.1 Overview
To start Standalone Client Web Applications

1. Follow the steps in this section of this guide entitled:  Chapter 5, "Starting the 
Standalone Client".

2. From the menu on the main screen, select Tools > EnterpriseOne Menu. 

The Standalone Client should automatically sign you into the Standalone Web Client.

6.2 Troubleshooting Standalone Web Client Startup Errors
This section discusses these troubleshooting topics:

■ Section 6.2.1, "General"

■ Section 6.2.2, "Cannot Connect to the Security Server"

6.2.1 General
If you have any trouble running the Web Client, look at the Web Client logs.

1. In Microsoft Windows Explorer, drill down to the location of the Web Client logs. 
By default, the logs are located in this directory:

C:\JDEdwards\E910\system\OC4J\j2ee\home\log

2. Examine any logs that were recently created, especially logs that are prefixed with 
either:

■ jas

■ jde

3. If you do not find any logs with the above prefixes, the logs may be in another 
folder. Use this procedure to determine the location of those logs:

a. In Microsoft Windows Explorer, drill down to this directory:

C:\JDEdwards\E910\system\OC4J\j2ee\home\applications\ 
webclient.ear\webclient\WEB-INF\classes
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b. Edit the file jdelog.properties.

Note:  The information at the top of the jdelog.properties file 
explains the uses and possible values of all the keys in the file.

Search through the file and note the value of the FILE key. In each of the 
sections that describe a log file there are section headers that are enclosed in 
square brackets ([ and ]). If a section header or the FILE key is commented out 
with a pound or hash sign (#), you can ignore that section. For example:

# [E1LOG]

or

# File=log\jderoot.log

The value of the FILE key in each section is the name and path of a log file 
associated with that section. For example:

File=log\jderoot.log

The actual file name will be the value of the FILE key with an underscore and 
the current date appended. For example:

jderoot_020512.log

If a log file name and path starts with a drive letter followed by a colon and 
slash, the path is absolute. This means that the log file will be located on the 
specified drive in the specified directory. For example:

File=c:\standalone_logs\jas_020512.log

If a log file name and path starts with a slash, the path is also absolute. This 
means that the log file will be located on the drive on which the E1 Standalone 
Client is installed and in the specified directory. For example:

File=\log\jderoot_020512.log

If a log file name and path start with neither a drive letter nor a backslash, the 
path is relative to this folder:

C:\JDEDwards\E910\system\OC4J\j2ee\home

For example, if the value for the FILE key is log\jas.log and the Standalone 
Client is installed in C:\JDEdwards\E910, the log file is written to:

C:\JDEdwards\E910\system\OC4J\j2ee\home\log

6.2.2 Cannot Connect to the Security Server
Problem:

After starting the Standalone Web Client from the Standalone Client, you get an error 
on the screen indicating that the Web Client could not connect to the security server.

Resolution:

Verify that the local database services are running using this procedure:

1. Go to Start > Control Panel -> Administrative Tools -> Services.

2. Verify that the statuses of these services are Started:

■ OracleServiceE1LOCAL
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■ OracleE1LocalTNSListener

If not, for each stopped service click Action > Start in the menu.

3. Try to sign in again by following these steps:

a. Exit from the Standalone Web Client and Standalone Client.

b. Run the Microsoft Windows Task Manager.

c. Wait for these processes to die:

– activConsole.exe

– jdenet_n.exe

– java.exe

Note:  The java.exe program is used by a variety of programs 
written in the Java programming language. One of these programs is 
the Standalone Web Client; however, it could be running for any 
number of other Java programs. It is difficult to tell in Microsoft 
Windows Task Manager if the java.exe is associated with the 
Standalone Web Client or with some other program. If you wait for a 
minute or more and a java.exe remains running, you can assume that 
it is associated with a Java program other than the Standalone Web 
Client. In that case, continue to the next step.

d. Rerun activConsole.exe to restart the Standalone Client, sign in, and start the 
Standalone Web Client (select Tools > EnterpriseOne Menu from the 
Standalone Client).
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7Replacing the JD Edwards EnterpriseOne 
Tools Release Component

The JD Edwards EnterpriseOne Applications Release 9.1/Tools Release 9.1 Standalone 
Client is shipped with a specific release of the Tools component, for example, 9.1. (The 
Tools component of the Standalone Client is also known as "system" or "foundation" 
code.) You can determine this particular release by examining the contents of this file:

C:\JDEdwards\E910\system\bin32\ptf.log

If Global Customer Support instructs you to update the Tools component to a newer 
release, follow the instructions in this chapter.

Notes:  Because you are replacing files that the Standalone Client 
installer uses, you will need to either copy the installer from a DVD to 
a hard drive or download the installer from Oracle Software Delivery 
Cloud. Follow the instructions in the section Downloading from the 
Oracle Software Delivery Cloud Site. 

For the following instructions, it is assumed that the folder where the 
Standalone Client installer resides is:

<drive>:\Standalone_9.10

■ To Replace the Tools component

1. If EnterpriseOne is running, stop it.

2. Use Task Manager to verify these processes are stopped:

■ activConsole.exe

■ jdenet_n.exe

If either or both of these processes are running, either wait for them to finish or kill 
them via Task Manager.

3. Download the appropriate Tools Release WINCLIENT from the Update Center. 
The download is transferred to your machine as a .par file. This file may be 
opened with the standard 7-Zip or WinZip program.



Caution: Improper Unzipping. You should not open the .par file by 
double clicking on it. It is a self-extracting file that is normally 
installed on a deployment server. If you double-click on it, it will 
assume that your workstation is a deployment server and attempt to 
install it in an incompatible manner.
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4.  Open the .par file with 7-Zip or WinZip.

5. Inside the .par file are multiple .CAB files in the Disk1\System folder. The files are 
called SystemX.CAB where X is either nonexistent or a whole number. Extract these 
.CAB files into the "system" folder where you placed the temporary installation 
directory (for example, \Standalone_9.10\system).

6. You can either:

a. Deinstall the existing Standalone Client and reinstall using the new 
foundation, or

b. Backup the existing system directory and reinstall the Standalone Client in the 
same Oracle Home path. 

If you are backing up your existing system directory in your installed Standalone 
Client, simply rename the system directory. For example, rename 
C:\JDEdwards\E910\system to C:\JDEdwards\E910\system_old.

Note: Unable to Rename. If Microsoft Windows does not allow you 
to rename the directory, one or more running java.exe processes may 
have the directory locked. In this case, either reboot your machine or 
use Microsoft Windows Task Manager to kill the java.exe process(es).

7. Follow the instructions in Section 4.4, "Installing the EnterpriseOne Client".

8. After reinstalling the client, it is best to clear the cache in your browser using these 
browser-dependent procedures:

Microsoft Internet Explorer

a. Go to Tools > Internet Options.

b. On the General tab, click the Delete Files... button.

c. Click the OK button.

d. Click the OK button.

e. Exit Internet Explorer.

Mozilla Firefox

a. Go to Tools > Options.

b. On the Network tab and in the Cache section, click the Clear Now button.

c. Click the OK button.

d. Exit Mozilla Firefox.

9. Launch EnterpriseOne by following the instructions in the section of this guide 
entitled: Chapter 5, "Starting the Standalone Client".



8

Working With SnapShot on the Standalone Client 8-1

8Working With SnapShot on the Standalone 
Client

Note: Tools Release 9.1 Update 2. This entire chapter is revised to 
support a significantly enhanced version of SnapShot that is available 
with Tools Release 9.1 Update 2 and higher. 

This section discusses these topics:

■ Section 8.1, "Understanding SnapShot"

■ Section 8.2, "Prerequisites"

■ Section 8.3, "Using Snapshot on the Standalone Client"

■ Section 8.4, "Renaming an Environment"

■ Section 8.5, "Manually Backing Up Files and Settings"

■ Section 8.6, "Set Logging for SnapShot Using the Registry"

8.1 Understanding SnapShot
The SnapShot program manages multiple instances of the JD Edwards EnterpriseOne 
Development or Standalone Client on a single machine. Using this program you can 
save and restore copies of an installed Development or Standalone Client.

Below is an example of SnapShot managing multiple tools releases including B7333 
(DV7333) and two installations of E910 (E910_DV and E910_PD).
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The preceding image shows the JD Edwards main SnapShot window. The main 
features of this window, from top to bottom, include:

■ Close (icon)

The Close icon is located in the upper right hand corner. Click this icon to exit 
SnapShot.exe.

■ System (icon)

The System icon is located in the upper left hand corner. Click on this icon or 
right-click on the title bar to display a drop-down menu that contains "About 
EnterpriseOne SnapShot…."  Selecting this item displays version and build 
information about SnapShot as shown below:
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■ Existing Version 

The Existing Version area contains these fields and buttons:

– Version

The Version field lists the existing installed Standalone Client.  Initially, this is 
the release specified in the installed package. After you save and then restore a 
SnapShot, this field will be the name that you gave the SnapShot when you 
saved it.

– Location

The Location field shows the JD Edwards EnterpriseOne installation directory.

– Save

Use the Save button to save the installed JD Edwards EnterpriseOne to a 
SnapShot.

– Rename

Use the Rename Environment button to rename the path code and 
environment names of the installed JD Edwards EnterpriseOne.

■ Saved Versions 

The Saved Versions area contains a field that lists saved versions (also called 
SnapShots). The example in this image shows the following versions: DV7333 and 
E910_PD.

■ Restore
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Use the Restore button to restore a saved version (SnapShot) to a runnable JD 
Edwards EnterpriseOne installation.

■ Delete

Use the Delete button to remove a saved version (SnapShot).

■ Log File

The Log File area displays the log file path and name.

■ Close

Use the Close button to exit SnapShot.exe.

8.2 Prerequisites
Before saving or restoring a JD Edwards EnterpriseOne installation using SnapShot, be 
sure that:

■ You are signed into Microsoft Windows using an account with sufficient privileges 
(for example: read, write, execute) to the registry and to the JD Edwards 
EnterpriseOne installation and saved directories.

■ All JD Edwards EnterpriseOne programs are closed.

■ No applications (for example, Windows Explorer) have a file or subfolder open in 
either the installation or the saved directory or one of their subdirectories.

■ The SnapShot.exe that you are running is not in either the installation or the saved 
directory or one of their subdirectories.

■ The database(s) that both the JD Edwards EnterpriseOne installation and the 
saved SnapShot use is installed and running.

■ Ensure that the Oracle product JDeveloper is not running.

Additional considerations:

■ Before installing a new Standalone Client into a new Oracle Home, make sure you 
do not have any previous versions in the Existing Version field of SnapShot.  All 
versions must be saved and should appear in the Saved Versions field.

8.3 Using Snapshot on the Standalone Client
To use SnapShot with multiple releases of the JD Edwards EnterpriseOne applications, 
you must use the most current version of SnapShot when switching between different 
releases of JD Edwards EnterpriseOne. For example, if you install the foundation code 
for both JD Edwards EnterpriseOne Applications Release 9.1 and Applications Release 
8.12, you must use the version of SnapShot corresponding to the most current JD 
Edwards EnterpriseOne tools release, in this case, Tools Release 9.1.

This section describes these tasks:

■ Section 8.3.1, "Starting SnapShot"

■ Section 8.3.2, "Saving a SnapShot"

■ Section 8.3.3, "Restoring a SnapShot"

■ Section 8.3.4, "Deleting a SnapShot"
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8.3.1 Starting SnapShot

Caution: Be sure to follow the guidelines in the preceding sections of 
this guide entitled: Section 2.2, "Windows Security".

As noted in this section, with the Tool Release 9.1 Update 2 and later 
versionof SnapShot, you do not have to right click on the 
SnapShot.exe icon and select "Run as administrator." This is because 
these versions of SnapShot.exe are designed to automatically attempt 
to start with the elevated permissions.  If you are not signed into 
Windows with an administrative account, you will be prompted to 
enter the credentials for an administrative account.

The SnapShot utility is delivered with the installation of the JD Edwards 
EnterpriseOne Development or Standalone Client. It is located in this directory:

<dev_client_installation_directory>\System\Bin32 

To run the most current version of SnapShot for multiple releases, you must copy the 
SnapShot.exe program to a directory outside the Development or Standalone Client 
installation directory. For example, the installation directory might be c:\E910. If you 
attempt to run SnapShot from within the Development or Standalone Client 
installation directory (for example, c:\E910), Snapshot will fail to rename the 
installation directory.

Tip: You can create a shortcut to SnapShot.exe, but you still must 
copy SnapShot.exe to a location outside the original installation 
directory where it was delivered.

8.3.2 Saving a SnapShot
To save a SnapShot:

1. On the main SnapShot window, click the Save button.
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2. On Make a New SnapShot, complete this field:

■ SnapShot Name

Enter a name for the SnapShot that will be saved.  You may choose any name 
with the exceptions that the name cannot be empty and it cannot contain a 
backslash ( '\' ).  A recommended scheme is to make it release specific, for 
example, Xe, B9, or E910.

■ New Folder Name

Provide a directory in which the snapshot will be saved. The directory should 
start with a backslash and be a valid Windows directory name.  It will be 
created on the indicated drive.

3. Click the OK button.

SnapShot saves a snapshot of the Standalone Client.

8.3.3 Restoring a SnapShot
To restore a SnapShot:
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1. On the main SnapShot window and in the Saved Versions section, highlight the 
saved instance that you want to restore.

2. Click the Restore button.

SnapShot restores the selected instance of JD Edwards EnterpriseOne and makes it 
active.

8.3.4 Deleting a SnapShot
To delete a SnapShot:
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1. On the main SnapShot window and in the Saved Versions section, highlight the 
instance that you want to delete.

2. Click the Delete button.

SnapShot completely removes the saved instance from the JD Edwards 
EnterpriseOne Standalone Client. 

8.4 Renaming an Environment
You can use SnapShot to rename the installed JD Edwards EnterpriseOne environment 
and path code.  An example of a use case for this functionality is when a JD Edwards 
EnterpriseOne administrator needs to promote one path code/environment 
combination to another. 

Note: When you use SnapShot the program does not update the 
database tables with the new path code and environment names.  
Instead, it simply updates the path code directory name and 
occurrences of the path code and environment in various files (for 
example, jde.ini, jdbj.ini, jas.ini, and pathcode.inf).  If the new 
path code or environment does not exist in the JD Edwards 
EnterpriseOne system tables, you will need to update those tables 
yourself either through JD Edwards EnterpriseOne or by using a 
database editing tool such as Oracle SQLPlus.

To rename an environment in SnapShot:
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1. On the main SnapShot window, ensure that an existing version of JD Edwards 
EnterpriseOne is active.

2. Click the Rename Environment button.

3. On Rename Environment, use the Select an installed path code to change 
drop-down to select the path code that you want to rename.

Note: The Old Values section on the left side of the window displays 
old path code and environment names.

4. In the New Values section of the window, enter the new names for the 
environment you want to rename.

5. Click the OK button.



Note:  The section of the screen entitled Select a view to change to is 
only available to JD Edwards EnterpriseOne internal application 
developers.

Manually Backing Up Files and Settings
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8.5 Manually Backing Up Files and Settings
Once you have saved a SnapShot for the Development or Standalone Client, it is a 
good idea to manually backup the saved directory to ensure that your settings for that 
Development or Standalone Client are secure.

The files and subdirectories that need to be backed up are found in the folder of each 
saved snapshot. You should backup these files and subdirectories only while the 
SnapShot.exe program is not running. These files contain the information necessary to 
restore registry values and settings for each SnapShot.

8.6 Set Logging for SnapShot Using the Registry
The version of SnapShot that is shipped with Tools Release 9.1 Update 2 and later 
always outputs the maximum amount of logging information. Furthermore, by design 
there is no way to turn off logging. You can specify the name and location of the log 
file that is generated by adjusting a single registry setting.

Caution: Changes made to the Microsoft Windows registry happen 
immediately, and no backup is automatically made. Do not edit the 
Windows registry unless you are confident about doing so.

Microsoft has issued the following warning with respect to the 
Registry Editor:

"Using Registry Editor incorrectly can cause serious, system-wide 
problems that may require you to re-install Windows to correct them. 
Microsoft cannot guarantee that any problems resulting from the use 
of Registry Editor can be solved. Use this tool at your own risk."

By default, the SnapShot log is located in the temp directory of the Microsoft Windows 
user.  This is the directory pointed to by the TEMP environment variable.  You can 
determine the value of this TEMP variable in a number of ways including:

1. Control Panel > System

2. In a command prompt window, enter this command:

echo %TEMP%

3. In the Address Bar of Windows Explorer, enter this string: 

%TEMP%

The default log file name is SnapShot_<date-time>.log. 

Both the directory and name of the SnapShot log can be specified by editing the 
registry; however, the date-time stamp will always be inserted immediately before the 
period.

To change the log file directory and/or name:

1. Open the registry by clicking on Windows Start button and entering regedit in 
the search field.



Troubleshooting

Working With SnapShot on the Standalone Client 8-11

2. Navigate to this node:

\HKEY_LOCAL_MACHINE\Software\Wow6432Node\JDEdwards\Snapshot

The first time that you run SnapShot, it creates a value (shown on the right-hand 
pane in regedit) called LogFileName with the default value SnapShot.log. You 
can change this value or, if it does not exist yet, you can add the value with name 
LogFileName, type string value, and the directory and/or file name of your 
choice.

3. The rules listed below are used for determining the final log file directory and 
name based on the value of LogFileName:

■ In all cases, the date and time that SnapShot.exe is run will be inserted 
immediately before the period in the extension of the file name.

■ If the value of LogFileName does not contain any backslashes, the name 
represents only the file name.  The value of the Windows TEMP variable will 
be used as the directory. 

■ If the value of LogFileName contains backslashes but does not start with a 
drive letter or a backslash, everything up to the last backslash represents a 
subdirectory or hierarchy of subdirectories below the directory designated by 
the Windows TEMP variable.  Everything after the last backslash is the file 
name.

■ If the value of LogFileName starts with a backslash, it represents a 
subdirectory below the root directory of the drive (that is, directory "\").  The 
drive letter is derived from the drive specified in the Windows TEMP variable.

■ If the value of LogFileName starts with a letter followed by a colon and 
backslash, the letter is considered the drive letter where the log will reside. 
Any other applicable rule in the preceding rules above then apply.

The following are examples of values of the LogFileName registry entry and the 
resulting log file path and name. In these examples, the assumed value of the 
TEMP variable is C:\Users\John\AppData\Local\Temp and assumes the log was 
created on June 5, 2012, at 3:46:9 PM.

Value for LogFileName Resulting Log File

SnapShot.log C:\Users\John\AppData\Local\Temp\SnapShot_2012-6-5_15-46-9.log

MyFile.txt C:\Users\John\AppData\Local\Temp\MyFile_2012-6-5_15-46-9.txt

MyTempDir\MyFile.txt C:\Users\John\AppData\Local\Temp\MyTempDir\MyFile_2012-6-5_15-46-9.txt

MyTempDir\MyFile.txt C:\MyTempDir\MyFile_2012-6-5_15-46-9.txt

D:\MyTempDir\MyFile.txt D:\MyTempDir\MyFile_2012-6-5_15-46-9.txt

4. Save the changes and exit the registry.

8.7 Troubleshooting
If SnapShot encounters a problem when trying to perform an action, it is designed to 
attempt to rollback the actions performed up to the point of failure.  This means that 
during a save operation, SnapShot attempts to restore the JD Edwards EnterpriseOne 
instance back to a runnable state.  If a failure occurs during a restore action, SnapShot 
attempts to resave the JD Edwards EnterpriseOne snapshot so you can correct the 
problem and then retry the action.



Caution: If a second error occurs when SnapShot is attempting to 
rollback changes, the error will likely result in either a non-runnable 
instance of JD Edwards EnterpriseOne or a saved snapshot that is 
corrupt.  In either case, you will probably need to reinstall JD Edwards 
EnterpriseOne. 
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This section describes these topics:

■ Section 8.7.1, "Examining the Log File"

■ Section 8.7.2, "Error Handling"

■ Section 8.7.3, "Remedial Actions"

8.7.1 Examining the Log File

When an error is encountered in SnapShot, the first thing that you should do is to 
carefully examine any on screen error messages for an indication of what went wrong 
and why. If you are not able to determine the cause and possible resolution of an error 
by examining the error message on the screen, examine the log file.  As shown in the 
preceding screen example, the location and name of the log file is specified in the Log 
File section near the bottom of the main SnapShot window. 
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Above is an example of a SnapShot log file. When troubleshooting within the 
SnapShot log file, you should scan the Type column for a status of ERR, which 
indicates an error.  If the error message itself is insufficient to isolate the cause of the 
problem, examine the messages immediately before and after the error for hints as to 
the root cause.

8.7.2 Error Handling
This section discusses these topics:

■ Section 8.7.2.1, "Locked Resources Prevent Directory Renaming"

■ Section 8.7.2.2, "Other Causes of Directory Renaming Failure"
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8.7.2.1 Locked Resources Prevent Directory Renaming

If an error occurs during a directory rename operation (for example, when saving or 
restoring a snapshot), the preceding window may appear.

The reason for the failure is displayed at the top of the window followed by some 
suggested remedies.  In a box immediately below that are some recommendations to 
resolve the error.  Another box lists processes running on the workstation that have 
one or more resources (for example, files, directories, handles, and so on) locked that 
prevented the directory rename action from succeeding-resulting in the Access is 
denied error.  Click on a process in the list to get a list of open resources for that 
particular process.
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When you highlight a Process, the list of resources in the Resources that are open for 
the selected process section at the bottom of the window shows the type as File for 
both files and directories.

It is important that you follow these steps to resolve the file or directory locking 
problem:

1. Attempt to gracefully close the programs that have a resource open. That is, close 
the program in the normal manner such as selecting File > Exit from the program's 
main menu.  You can attempt to close just the resource, but many programs 
continue to hold a lock on a resource (such as a file) even after closing that 
resource.  Freeing the resource may require closing the actual program.  For 
example, you may have to close Microsoft Word instead of simply closing the file 
from within Microsoft Word.

2. If the program does not terminate, you may have to resort to forcefully 
terminating it using Microsoft Task Manager.
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3. The SnapShot.exe program may appear in the list of active programs either by 
itself or along with other processes that are locking resources.  First, be sure that 
you are not running SnapShot.exe from within either the installation or the save 
directory or one of their subdirectories.

4. If the SnapShot.exe program is listed with other programs, try to close those other 
programs and then click Retry.  

5. If the SnapShot.exe is the lone program listed, simply click Retry.  Many times, 
the rename action will continue after the second Retry.

6. Not all 64-bit programs are automatically shown in the list of locking processes. 
You may need to examine all the running programs on your system to determine 
which one may be preventing the rename action from succeeding.

7. If you cannot close the program(s) that holds the lock(s) on the necessary 
resource(s) or determine which program(s) holds a lock, click Cancel, exit from 
SnapShot, reboot the machine, run SnapShot and try the action again.

8.7.2.2 Other Causes of Directory Renaming Failure
Besides locked resources described in the preceding section, there are other reasons 
that can cause a directory rename operation to fail.  

The preceding window may appear during a directory rename operation (that is, 
when saving or restoring a snapshot). In this case, either SnapShot could not 
determine which processes hold locks on resources in the installation or save 
directories or some other reason caused the directory rename to fail. For example, 
perhaps the user did not have read or write permissions on one of the affected 
directories or subdirectories.

8.7.3 Remedial Actions
In some cases, SnapShot may not be able to recover from errors that occur during a 
save or restore action.  You may be able to salvage either the JD Edwards 
EnterpriseOne installation or the saved instance.  If these operations fail, you will need 
to reinstall JD Edwards EnterpriseOne.

This section describes these topics:
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■ Section 8.7.3.1, "Examples of Healthy Environments"

■ Section 8.7.3.2, "Simple Fixes"

8.7.3.1 Examples of Healthy Environments
This section illustrates a healthy JD Edwards EnterpriseOne installation and saved 
snapshot directories and registry settings.

The preceding shows the installation directory of a healthy JD Edwards EnterpriseOne 
instance.
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In the preceding example screen, note that when you save a snapshot of the JD 
Edwards EnterpriseOne installation, the highlighted files and subdirectory shown 
above are created. Here are brief descriptions of the new files and subdirectory.

■ STARTMENU*.*

The subdirectory that is prefixed with STARTMENU is the folder in the Start menu for 
the original installation.

■ DESKTOP*.*

The file that starts with DESKTOP is the shortcut to JD Edwards EnterpriseOne that 
was on the desktop of the workstation.

■ jde.ini

The jde.ini file is the same file that was in the c:\Windows directory.

■ RegKeys*.*
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The files that are prefixed with RegKeys are binary files that contain the saved 
registry entries.

The preceding image shows the registry entries for a healthy JD Edwards 
EnterpriseOne Standalone Client installation.
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The preceding image shows the registry keys for a saved JD Edwards EnterpriseOne 
snapshot.

8.7.3.2 Simple Fixes
Not all issues can be resolved by simple steps. However this section describes a few 
simple fixes for these conditions:

■ Section 8.7.3.2.1, "Missing Version Information"

■ Section 8.7.3.2.2, "Missing Saved Version"
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8.7.3.2.1 Missing Version Information  

If the Existing Version fields are empty when you run SnapShot.exe and you are 
certain that a JD Edwards EnterpriseOne instance is active, it is likely that this file is 
missing: 

c:\Windows\jde.ini

If you happened to save a copy of the jde.ini file when you last saved a snapshot of 
this installation, you can copy that jde.ini file into the c:\Windows directory and 
rerun SnapShot.exe.
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8.7.3.2.2 Missing Saved Version  

If a saved snapshot is not listed in the Saved Versions field and you know that the 
saved snapshot exists, some registry entries are probably missing or pointing to the 
wrong directory.

To resolve this issue, perform these steps:

1. Edit the registry with regedit.exe.

2. Create a subkey under this path:

\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JDEdwards\SnapShot

The name that you give for the subkey should be the name of the saved snapshot.

3. Click on the subkey that you just created.

4. Create a string value called SaveDir.

5. Set the value data for this to the directory where the saved snapshot is stored.

6. Create a second string value called InstallDir.

7. Set the value data for this to the installation directory (that is, the directory in 
which the saved snapshot will be restored).

The following image illustrates properly configured registry entries.
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9Deinstalling the Standalone Client or the OEE 
Database (optional)

This chapter contains the following topics:

■ Section 9.1, "Deinstalling the Standalone Client"

■ Section 9.2, "Deinstalling the OEE Database (optional)"

Caution: To minimize the possibility that the Standalone Client 
installer or deinstaller or Snapshot might fail due to locked files, 
follow these guidelines:

1. Exit from all running programs. You can use Microsoft Windows Task 
Manager to verify that the programs are stopped. In particular, be sure 
that EnterpriseOne, JDeveloper, and SQL Developer are stopped, but 
other programs may also need to be stopped. Exceptions to this rule 
include the database service(s) which should be running when 
deinstalling or saving a snapshot of the Standalone Client.

2. Verify that no files in the Standalone Client installation directory or 
subdirectories are open in any file editors.

3. Verify that neither the installation directory nor any of its subdirectories 
are open in Microsoft Windows Explorer.

4. Verify that no Command Prompt window has as its current working 
directory either the Standalone Client installation directory or any of its 
subdirectories. Verify that neither the installation directory nor any of its 
subdirectories are open in Microsoft Windows Explorer.

9.1 Deinstalling the Standalone Client
To deinstall the Standalone Client

1. If EnterpriseOne is running, stop it.

2. Use Task Manager to verify these processes are stopped:

■ activConsole.exe

■ jdenet_n.exe

If either or both of these processes are running, either wait for them to finish or kill 
them via Task Manager.

3. Go to Start > All Programs > Oracle - JDE_Standalone_Home > Oracle Installation 
Products > Universal Installer.
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A Windows Command prompt displays as OUI initiates.

4. On Welcome, click the Deinstall Products… button.
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5. On Inventory, click the check box next to the item with the Oracle Home name that 
you gave to your E1 client. For example, JDE_Standalone_Home1.

Note: ADo not drill down to select individual components to 
remove.

Caution: At this step, you should select only the Oracle Home that is 
associated with this particular OUI. That is, the Oracle Home name 
that you select on this screen should match the Oracle Home name 
that you selected from Start > Programs.

6. With the Oracle Home for JDE Standalone selected with a check mark in the 
associated check box, click the Remove button. 
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7. On Confirmation, click the Yes button.

The Remove dialog indicates the deinstall is dropping the Oracle tablespaces and 
directories that were installed for JD Edwards EnterpriseOne Standalone.
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When the deinstall is complete, the Inventory panel is displayed confirming that 
the JDE_Standalone product is not installed. 

8. On Inventory, click the Close button, which returns you to the Welcome screen of 
the OUI installer.
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9. On Welcome, click the Cancel button to exit from the Oracle Universal Installer.

10. In Windows Explorer, verify that the installation directory (Oracle Home) has been 
deleted. If it still exists, you can delete it. For example, if this directory exists you 
can delete it:

C:\JDEdwards\E910

Once the JD Edwards Standalone Client is deinstalled, you can deinstall the OEE 
database if you so desire. For instructions, refer to Section 9.2, "Deinstalling the 
OEE Database (optional)".

9.2 Deinstalling the OEE Database (optional)

Note:  Ensure Standalone Client is Deinstalled. If the Standalone 
Client is installed, you must deinstall it before deinstalling the 
database. Refer to the section in this guide entitled: Section 9.1, 
"Deinstalling the Standalone Client".

This section contains these tasks:

■ Section 9.2.1, "Deinstalling the OEE 11gR2 Database"

■ Section 9.2.2, "Verifying the Database Deinstallation"

9.2.1 Deinstalling the OEE 11gR2 Database
When OEE was installed, it was installed into a subdirectory called "E1Local" under a 
database target directory. By default, this database target directory was C:\Oracle. 
This means that the database was installed into c:\Oracle\E1Local by default. This 
path is used in the deinstall steps listed below.

1. Stop the database services from Control Panel > Administrative Tools > Services:

OracleE1LocalTNSListener

OracleServiceE1LOCAL

2. Be sure no Oracle processes from the c:\Oracle\E1Local directory are running.

3. From the c:\Oracle directory, right click and choose:

CMD Prompt Here as Administrator

Note: Confirm that "Administrator:" is displayed in the title of the 
command window.



Caution: It is important that you do not "cd" to any directory below 
c:\Oracle to run this command. If you do make one of these 
directories the current directory, the OUI deinstaller will not be able to 
delete that directory.
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4. Run this program:

c:\Oracle\E1Local\deinstall\deinstall.bat

5. During installation, the OEE installer program should have created several files in 
the c:\Oracle\E1Local\deinstall directory. If the files were successfully created, 
the deinstall.bat program will not prompt for any input from the user. If for 
some reason the files were not created or no longer exist, the deinstall.bat 
program will prompt the user for information needed to deinstall the database. 
You can take the default values (shown in square brackets) for most of the 
prompts. These are the prompts:

a. Specify all Single Instance listeners that are to be de-configured [LISTENER]:

b. Specify the list of database names that are configured in this Oracle home 
[E1LOCAL]:

c. Specify the type of this database (1.Single Instance Database|2.Oracle Restart 
Enabled Database) [1]:

d. Specify the diagnostic destination location of the database 
[c:\Oracle\diag\rdbms\e1local]:

e. Specify the storage type used by the Database ASM|FS []:

Note: This prompt requires a response. Enter FS.

f. Specify the list of directories if any database files exist on a shared file system. 
If 'E1LOCAL' subdirectory is found, then it will be deleted. Otherwise, the 
specified directory will be deleted. Alternatively, you can specify list of 
database files with full path [ ]:

g. Specify the flash recovery area location, if it is configured on the file system. If 
'E1LOCAL' subdirectory is found, then it will be deleted. []:

h. Specify the database spfile location [ ]:

i. Do you want to continue (y - yes, n - no)? [n]:

Note: This prompt requires a response. Enter "y".



Caution: After you go through the above prompts, you also need to 
manually delete this registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ORACLE\KEY_E1Local

Deinstalling the OEE Database (optional)

9-8 JD Edwards EnterpriseOne Standalone Client Installation

6. When the deinstall finishes, be sure that this directory no longer exists:

c:\Oracle\E1Local

If the directory exists, you should manually delete it. 

Caution: It is very important that no files exist in the "E1Local" 
subdirectory when you next attempt to install the OEE database. If 
any files do exist, the OEE installation will probably fail. 

If the database does not deinstall cleanly for some reason, you will 
need to manually remove it. Follow the instructions in the Appendix 
of this guide entitled: Appendix B, "Manual Cleanup of a Deinstalled 
Oracle Database".

7. Perform the steps in the section below entitled: Section 9.2.2, "Verifying the 
Database Deinstallation".

9.2.2 Verifying the Database Deinstallation
Use this procedure to verify that the proper keys were removed from the registry:

1. Go to Start > Run….

2. In the Open field, enter this command to start the Registry Editor:

regedit

3. Click on and expand these keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Oracle

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Oracle

4. If the sub-key KEY_E1Local exists under either of the above keys, delete it.
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5. Click on and expand this key:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services

6. If the keys OracleE1LocalTNSListener or OracleServiceE1LOCAL exist, delete 
them.

7. Exit the regedit program.

8. Reboot the computer.

9. Delete this folder:

C:\Oracle\E1Local

Note: No Files Can Exist In This Folder. It is very important that no 
files exist in this folder when you next attempt to install the OEE 
database. If any files do exist, the next OEE installation will probably 
fail.

10. If you cannot delete the folder because a file in that folder is locked, follow these 
steps:

Determine which file is locked and which process has the lock on the file. A 
freeware program called Process Explorer can be helpful in determining this 
information. You can obtain a free copy of Process Explorer from this web site: 
www.sysinternals.com

Either kill the locking process with Process Explorer or Microsoft Windows Task 
Manager or, if the process was started as a Microsoft Windows service, change the 
Startup Type to Manual and reboot the computer again.

Try again to delete the folder.
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AManual Cleanup of a Deinstalled Standalone 
Client

Caution: To minimize the possibility that the Standalone Client's 
installer or deinstaller or SnapShot might fail due to locked files, 
follow these guidelines:

1. Exit from all running programs. You can use the Microsoft Windows Task 
Manager to verify that the programs are stopped. In particular, be sure 
that EnterpriseOne, JDeveloper, and SQL Developer are stopped, but 
other programs may also need to be stopped. Exceptions to this rule 
include the database service(s) which should be running.

2. Verify that no files in the Standalone Client installation directory or 
subdirectories are open in any file editors.

3. Verify that neither the installation directory nor any of its subdirectories 
are open in Microsoft Windows. Explorer.

4. Verify that no Command Prompt window has as its current working 
directory either the Standalone Client installation directory or any of its 
subdirectories.

If the deinstallation of the Standalone Client fails for some reason, you need to 
perform the manual steps in this procedure to completely remove the old installation 
before reinstalling the Standalone Client.

1. Drop the OEE tablespaces.

a. Decrypt the database password by running this program:

c:\E910\system\bin32\ReconfigureMSDE.exe

Note: When running the program and UAC is turned on, you must 
right click on the executable or shortcut and select Run as 
Administrator.

b. Near the top, select the type of local database.

c. Under Change from password, turn on "Encrypted E1 Password."

d. In the To password field, enter a password that you will remember.

e. Click OK.

f. Perform the below steps.
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i. Open a command prompt window with "Run as administrator."

ii. Enter this command:  

set ORACLE_HOME=c:\Oracle\E1Local

iii. Enter this command:

sqlplus sys as sysdba

iv. When prompted, enter the password that you specified in 
ReconfigureMSDE.exe.

v. Enter this command:  

select unique tablespace_name from all_tables;

vi. Note the EnterpriseOne tablespace names.

vii. Repeat this command for each E1 tablespace:

drop tablespace <tablespace_name> including contents and datafiles;

viii. Enter this command:  

shutdown;

ix. Enter this command:  

startup;

x. Exit the command prompt window.

2. Delete the following registry keys, where  <JDE_Client_Oracle_Home_Name> is the 
name of the Oracle Home for the Standalone Client that you specified during 
installation.

\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ORACLE\KEY_<JDE_Client_Oracle_
Home_Name> 

3. Delete the following registry keys: 

\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JDEdwards\BPMBroker 

\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JDEdwards\HTMLWebServer 

\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JDEdwards\OneWorld  

4. Delete the installation directory for the Standalone Client (for example, c:\E910).

If you cannot delete the installation directory because a file in that directory is 
locked, follow these steps:

a. Determine which file is locked and which process has the lock on the file. A 
freeware program called Process Explorer can be helpful in determining this 
information. You can obtain a free copy of Process Explorer from this web site:

http://technet.microsoft.com/en-us/sysinternals

b. Either kill the locking process with Process Explorer or Microsoft Windows 
Task Manager or, if the process was started as a Microsoft Windows service, 
change the Startup Type to Manual and reboot the computer.

c. Try again to delete the E1Local subdirectory.

5. Remove the 32-bit Oracle inventory entries.

a. With a text editor (such as Notepad), edit this file:

c:\Program Files (x86)\Oracle\inventory\ContentsXML\inventory.xml 
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b. Delete any lines that start with:

<HOME NAME="JDE_Client_Home_Name"

where JDE_Client_Home_Name is the name that you gave the installation 
directory when you installed the Standalone Client.

c. Save the file.

6. Remove the entry from the Windows PATH.

a. From Windows' Start button, go to Control Panel / System.

b. Click Advanced system settings on the left.

c. Click Environment Variables… near the bottom.

d. In the System variables box near the bottom, highlight Path and click the 
Edit... button.

e. In the Variable value field, delete  <JDE_Client_Home>\system\bin32  where 
<JDE_Client_Home> is the path that you specified when you installed the 
Standalone Client. Be sure to remove the semicolon as well.

f. In the Variable value field, delete  <JDE_Client_Home>\DEMO\bin32   where 
DEMO is the name of the installed pathcode. Be sure to remove the semicolon as 
well.

g. Click OK.

7. Remove the JDE_B9_ICU_DATA Windows environment variable.

a. Navigate to Control Panel > System.

b. Click Advanced system settings on the left.

c. Click Environment Variables… near the bottom.

d. In the System variables box near the bottom, highlight JDE_B9_ICU_DATA 
and click Delete.

e. Click OK.
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BManual Cleanup of a Deinstalled Oracle 
Database

If the deinstallation of the OEE database fails for some reason, you need to perform the 
manual steps in this procedure to completely remove the old installation before 
reinstalling the database.

1. Deinstall the Standalone Client.

Be sure the Standalone Client is deinstalled before attempting to deinstall the 
database. This should ensure that no EnterpriseOne tablespaces are imported 
(attached) to the EnterpriseOne database.

2. Delete the following registry keys:

\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_E1Local

\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ORACLE\KEY_E1Local 

\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\(see Keys below)

Keys. Delete any keys with names that start with "Oracle" and contain "E1Local". 

3. Delete this directory:

c:\Oracle\E1Local

If you cannot delete the E1Local subdirectory because a file in that directory is 
locked, follow these steps:

a. Determine which file is locked and which process has the lock on the file. A 
freeware program called Process Explorer can be helpful in determining this 
information. You can obtain a free copy of Process Explorer from this web site:

http://technet.microsoft.com/en-us/sysinternals

b. Either kill the locking process with Process Explorer or Microsoft Windows 
Task Manager or, if the process was started as a Microsoft Windows service, 
change the Startup Type to Manual and reboot the computer again.

c. Try again to delete the E1Local subdirectory.

4. Remove the 64-bit Oracle inventory entries.

a. With a text editor (such as Notepad), edit this file:

c:\Program Files\Oracle\inventory\ContentsXML\inventory.xml

b. Delete any lines that start with: 

<HOME NAME="E1Local"

c. Save the file.



B-2 JD Edwards EnterpriseOne Standalone Client Installation

5. Remove the entry from the Windows PATH.

a. Navigate to Control Panel > System.

b. Click Advanced system settings on the left.

c. Click Environment Variables… near the bottom.

d. In the System variables box near the bottom, highlight Path and click the 
Edit… button.

e. In the Variable value field, delete this value:

c:\Oracle\E1Local\bin

Be sure to remove the semicolon as well.

f. Click OK.

6. Remove the ORACLE_HOME Windows environment variable.

a. Navigate to Control Panel > System.

b. Click Advanced system settings on the left.

c. Click Environment Variables… near the bottom.

d. In the System variables box near the bottom, highlight ORACLE_HOME and 
click Delete.

e. Click OK.
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This glossary provides descriptions of terms and acronyms used in this document.

Database driver

A set of code used to connect to a database.

Oracle Software Delivery Cloud

An Oracle site from which applications can be downloaded.

H4A (HTML for Applications)

The Standalone Web Client.

Install Manager

The JD Edwards EnterpriseOne program that starts the Standalone Client installer. The 
actual program name is Installmanager.exe.

Java Development Kit (JDK)

A set of tools and Java code used to develop Java applications.

Java Runtime Environment (JRE)

A set of tools used when running Java applications.

JDBC driver

A database driver that is used by Java programs to connect to a database.

Local database

A database that resides on the workstation on which the Standalone Client is installed.

Minimum Technical Requirements (MTRs)

The minimum software and hardware requirements needed to install and run the 
Standalone Client.

Oracle Enterprise Edition (OEE)

A version of the Oracle database product. The particular version of OEE that is used 
and installed by the Standalone Client is a stripped down version intended only for JD 
Edwards EnterpriseOne client and deployment server installations.

Oracle Universal Installer (OUI)

A program that is used to install Oracle products. This version of the Standalone 
Client is installed using OUI. OEE is also installed by OUI.
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Root folder

The base-level folder of a computer drive whether that drive is a hard drive or a DVD. 
It is designated by the drive letter, a colon, and a backslash or, if the drive letter can be 
assumed, simply by a single backslash.

Snapshot

A JD Edwards EnterpriseOne tool used to save and restore installations of JD Edwards 
EnterpriseOne products such as standalone clients, development clients, and 
deployment servers.

Software Protection Codes (SPCs)

Encrypted alphanumeric strings used to designate the number and expiration date of 
licenses used to run previous versions of JD Edwards EnterpriseOne, including 
standalone clients, development clients, and deployment servers. The 9.1 release of the 
Standalone Client does not require SPCs.

Spec database

A database that contains information ("specifications" or descriptions) about JD 
Edwards EnterpriseOne objects such as database tables, applications, and components 
of applications (forms, event rules, etc.).

SQL Server 2005 Express Edition (SSE or SSEE)

The version of the Microsoft SQL Server database product intended to run on 
individual client Microsoft Windows workstations.

Standalone Client

A JD Edwards EnterpriseOne Applications Release 9.1/Tools Release 9.1 client that 
does not require any of these associated EnterpriseOne servers:

■ Deployment Server

■ Enterprise Server (also known as host or logic server)

■ HTML Web Server

■ Database Server

Standalone Web Client

The web browser based component of the JD Edwards EnterpriseOne Standalone 
Client.

Tools component

The JD Edwards EnterpriseOne component of the Standalone Client that provides 
mid-level functionality to the EnterpriseOne applications. Also known as JD Edwards 
EnterpriseOne Tools Release or "system" code or "foundation" code.
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